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[bookmark: _Toc19721473]Welcome
Welcome to the CTR Research Report Template. This template provides a simple structure for writing and formatting research reports, using Microsoft Word styles. You will find contact information for help with this template at the end of this chapter. Chapter 2 illustrates styles used in the report template. 
Note that the chapter number and title are on the same line. This makes our job a little easier when we are inserting metadata and bookmarks into the PDFs prior to your report’s online publication. Metadata makes it easier for people to find your work online (search engines pull from PDF metadata) and bookmarks make it easier for people to find what they are looking for within your work.
[bookmark: _Toc19721474]How to Use Styles
Microsoft Word “styles” are different types of formatting (font type and size, line spacing, justification, etc.) saved and named so that you may easily apply the same type of formatting throughout a document. The following sections describe how to access and use styles in Word 2010 and beyond. 
1.1.1. [bookmark: _Toc19721475]Finding the Styles
To apply styles to your text, go to the Styles group on the Home tab. You can quickly apply a style from the gallery of styles—just select the text you’d like to apply a style to, and click on the style name. To see a complete list of the available styles in your document, click the Styles Dialog Box Launcher by hitting the little arrow in the bottom right corner of the Styles group (circled in red in Figure 1.1).
[image: ]
[bookmark: _Ref498090574][bookmark: _Toc19721497]Figure 1.1 The Styles group on the Home tab
[bookmark: _Toc19721476]How to Automate Caption Numbering and Cross-References
[bookmark: _Toc19721477]Using the “Insert Caption” Function
To get the auto-numbering on the figure caption, by the way, select the graphic and go to the References tab, where you’ll hit “Insert Caption” (as Figure 1.2 shows). In the “Caption:” box will appear the item type and number (such as Figure 1.1); you just go ahead and type in your caption in that box and hit OK. Once the caption appears below your figure, please style it with “ctr figure caption.”
[image: ]
[bookmark: _Ref498090660][bookmark: _Toc19721498]Figure 1.2 The caption creation dialog box
[bookmark: _Toc19721478]Using the “Cross-Reference” Function
If you’d like, you can insert an auto-updating figure or table number in your text. This is handy if you are adding/removing tables and want your in-text references to match up with your new table and figure numbers (without having to manually update them). Just position your cursor where you want the figure number to go, then go back to the References tab and hit “Cross-reference” to arrive at the dialog box shown in Figure 1.3. Make your selections from the reference type box and set the “Insert reference to:” field to “Only label and number.” Hit OK and you’ll see the cross-reference content pop up in your text.
[image: ]
[bookmark: _Ref498091124][bookmark: _Toc19721499]Figure 1.3 The cross-reference dialog box
[bookmark: _Toc19721479]Applying Automation to Table Titles Too
All the tips about creating automated captions and cross-references for figures goes for tables titles and cross-references as well. And some other text items too, but for simplicity we are sticking to tables and figures right now. Note that Table 1.1 is just a sample—you don’t have the make your tables match that style or appearance. Remember: once the title appears above your table, please style it with “ctr table title.”
[bookmark: _Ref499640034][bookmark: _Toc19721494]Table 1.1 Here's a sample table.
	Variable
	Coeff.
	t-stat

	Constant
	-6.116
	-0.83

	GDPt,t-1
	1.151
	2.14

	Dlinesq,t-Dlinesq,t-1
	-0.670
	-2.32

	RPSt
	10.623
	2.27


Updating the Auto-Numbering
Here’s a quick way to make your in-text references updates themselves if you have moved or deleted your figures and tables: you can hit Ctrl A (to select the entire document) + F9. This updates all the updateable fields in your document. You’ll notice that if you go to print without having updated your fields (Ctrl + P), Word will automatically update them. In fact, Ctrl + P is a smoother update—but you don’t have to actually print! You can just back out of that screen using that arrow in the top left corner, circled in Figure 1.4.
[image: ]
[bookmark: _Ref499638514][bookmark: _Toc19721500]Figure 1.4 The print dialog box—escape hatch in the top left corner
Addressing Potential Auto-Linking Error Messages
Figure 1.5 is just an example figure. Here’s a fun experiment: delete Figure 1.5 and its caption, then update your fields and see what happens to the cross-reference that begins this paragraph.
[image: ]
Source: image source
[bookmark: _Ref497996267][bookmark: _Toc19721501]Figure 1.5 Example figure caption
[bookmark: _Toc19721480]Styles Used in This Template
Listed below are the template styles in the order they appear in this document. The next chapter illustrates all these style. 
ctr DOT fields (used in the DOT form)
ctr front matter title (used for the titles of front matter sections such as Disclaimers and Acknowledgements)
Heading 1 (use this for your chapter titles to take advantage of the auto-numbering of Headings 2 through 6)
Heading 2
Heading 3
Heading 4
Heading 5
ctr body text
ctr figure caption
ctr table title
ctr bulleted list
ctr bulleted sublist
ctr blockquote
ctr back matter title
ctr references listing
ctr appendix subhead
ctr figure caption (appendix)
ctr table title (appendix)
[bookmark: _Toc19721481]Margins and Such
We’ve set the margins at 1 inch on top and bottom and 1.5 on both right and left sides. The narrower columns make for easier reading online, where this document will eventually be appear once it is approved for publication. Also, you’ll notice that our body text is single-spaced, no initial indent, with 10 points of space between paragraphs instead of hard returns. All the main body text is styled as “ctr body text.”
[bookmark: _Toc19721482]Need Help?
Contact Maureen Kelly in CTR’s Production Department: maureenk@mail.utexas.edu or 512.232.3128.

[bookmark: _Toc19721483]Heading 1
The style used for paragraph blocks is ctr body text. Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris
[bookmark: _Toc19721484]Heading 2
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore eis.
[bookmark: _Toc19721485]Heading 3
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incidids. See Figure 2.1
[image: ]
Source: ctr source
[bookmark: _Ref498004894][bookmark: _Toc19721502]Figure 2.1 ctr figure caption
Heading 4
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation.
Heading 5
Loremetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. See Table 2.1.
[bookmark: _Ref497996423][bookmark: _Ref498004650][bookmark: _Toc19721495]Table 2.1 ctr table title
	Class
	WPD
	Wind Speed (meter/second)

	1
	0–200
	0.0 – 5.6

	2
	200–300
	5.6 – 6.4

	3
	300–400
	6.4 – 7.0

	4
	400–500
	7.0 – 7.5


[bookmark: _Toc481679763]
Quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat. Duis aute irure dolor 
This style is ctr blockquote. It has the required characteristics of a blockquote: indented on both sides and a smaller font. Lorem in voluptate velit esse cillum dolore eu fugiat nulla pariatur. 
[bookmark: _Toc19721487]Back Matter Styles
Finally, we have the back matter styles, which govern the appendices and references. These sections do not follow the numbering of the main body of the report, so they use a different style while giving a uniform appearance.
But first, a word (or a chapter) on accessibility and other required or suggested features.


[bookmark: _Toc19721488]Get Your Work Read
An essential component of research is publication. Publication won’t get you far without distribution, however. Make sure your work is accessible to all readers by using these ADA/508 guidelines and meeting the standards that are increasingly becoming mandatory for online publication and distribution. For example, the USDOT’s National Transportation Library no longer accepts new reports into their repository if the PDF does not meet 508 guidelines, due to this ruling: 
On January 18, 2017, the U.S. Access Board published a final rule updating accessibility requirements for information and communication technology (ICT) covered by Section 508 of the Rehabilitation Act and Section 255 of the Communications Act.
[bookmark: _Toc19721489]Know and Use Your ORCID ID
ORCID is a nonprofit organization helping create a world in which all who participate in research, scholarship, and innovation are uniquely identified and connected to their contributions and affiliations, across disciplines, borders, and time. As of January 1, 2016, ORCIDs are required for researchers who must comply with the USDOT Public Access Plan—this means you. 
ORCID provides a persistent digital identifier that distinguishes you from every other researcher and, through integration in key research workflows such as manuscript and grant submission, supports automated linkages between you and your professional activities ensuring that your work is recognized.
On the DOT form (that very first page), provide the ORCID URL after each author name, when available. 
Example: Josiah Carberry, Ph.D. http://orcid.org/0000-0002-1825-0097
[bookmark: _Toc19721490]Ensure Your Files Are Accessible
Researchers are responsible for ensuring that their electronic document complies with state and federal accessibility requirements, such as Section 508 and WCAG 2.0 standards.
Using the headings and inserting the table/figure labels will be quite helpful to you in attaining accessibility, because these style are customized versions of the built-in Word settings, which ensures one key aspect of ADA/508 compliance will already be in place once the Word file is converted to PDF. (Plus, using the styles will enable a table of contents and list of tables/figures that can be automatically updated when content moves around during revisions.)

[bookmark: _Toc19721491]References	Comment by Maureen Kelly: The style used here is ctr back matter title.
This style is ctr references listing. (2008) Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. 
American Wind Energy Association (2014) Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.
Apergis, N., and Payne, J. E. (2010) Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.

	Reminder: the authors are responsible for ensuring references are properly formatted and cited, with a consistently applied format for both the references listings and the in-text cites. 
If you need help correctly formatting your references, check out NoodleTools—a web-based student research service that helps you correctly cite sources in MLA, APA, and Chicago/Turabian citation styles. Use NoodleTools throughout a research project to track your sources, take notes, create outlines, collaborate with classmates, and format your references list. 
Available through the UT Library System: https://guides.lib.utexas.edu/citesources/noodletools 
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[bookmark: _Toc481679764][bookmark: _Toc19721492]Appendix A. Landscape Example	Comment by Maureen Kelly: The style used here is ctr back matter title.
Right now the appendices continue to be manually numbered. 
[image: ]
[bookmark: _Toc19721496]Figure A.1 Here’s another sample figure.


[bookmark: _Toc481679765][bookmark: _Toc19721493]Appendix B. Portrait Example
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation laborum.
Appendix Subhead	Comment by Maureen Kelly: The style used here is ctr appendix subheading.
The following table is manually numbered. I’m working on a way to create autonumbered styles based on appendix numbering—Word is resistant so forth to having two independently automated systems in one file. Stay tuned!
[bookmark: _Toc19721503]Table B1. Another sample table
	Variable
	Coeff.
	t-stat

	Constant
	-6.116
	-0.83

	GDPt,t-1
	1.151
	2.14

	Dlinesq,t-Dlinesq,t-1
	-0.670
	-2.32

	Adjusted R square
	0.250
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